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What is Computer? 

A computer is a machine or device that performs processes, calculations 

and operations based on instructions provided by a software or hardware 

program. It is designed to execute applications and provides a variety of 

solutions by combining integrated hardware and software components. 

 

Characteristics of Computer 

Computer may be defined as a device that receives some kind of data, 

analyses it, and then applies a pre- defined set of instructions to it to 

produce some kind of output. 

The following are Characteristics of a computer. 

1. Speed : Computers  operate at very high speed. A computer can 

perform several million instructions in one second. For example it 

can add or multiply  2,000,000 numbers in a second. There are 

several different types of computers and they all have different 

speeds ranging from high to very-very high. 

2. Accuracy: computers perform with very high degree of consistent 

accuracy. If you ask a computer to perform a particular calculation 

say, division of two numbers a thousand division operations with the 

same accuracy. 

3. Diligence : When human beings required to work continuously for a 

few hours, they become tired and start losing concentration. On the 

other hand, a computer can work continuously at the same speed and 

accuracy. It does not show signs of tiredness or lack of concentration 

when made to work continuously, unlike human beings.  It does not 
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complain or show laziness when made to do the same task 

repeatedly. 

4. Versatility : Computers are very versatile. The same computer can be 

used for various applications for instance you can use a personal 

computer to prepare a letter, prepare the balance sheet of a 

company, store a database of employees, produce a professional 

looking advertisement, send or receive fax messages etc. for a 

computer to perform a new job all it needs is a program. 

5. It can store data : A computer can store a huge amount of data in its 

memory you can store almost any type of data, such as a letter, 

picture, sound etc. in a computer you can recall the store data from 

the computer whenever you need it. For instance if you type a letter 

you can save it then if you want to send a similar letter to another 

person, you can recall that letter from the computer’s memory. The 

information can be stored in a computer’s memory. For several years 

and it will be 100% accurate and complete, 

6. It is Dumb :  A computer is a dumb. It has no intelligence of its own. It 

cannot think or apply its judgment. It is set its power from the 

program that it runs. It will do only what it is asked to do. It has to be 

told what to do. And in what sequence so, a computer does not take 

its own decisions. It simply follows the instructions of the 

programmer or the user. 

7. It has no emotions: computers are not living beings. Hence, they do 

not have any emotions they do not have any heart or soul. Human 

beings often take some decision based on emotions, taste, feelings 

etc. in their daily life on the other hand computers always take 

decision based on the program that they run. 
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What is Input Device? Explain 
Keyboard in brief. 

Computer need to receive data and instruction in order to solve any 

problem. So with the help of input device user can enter data and 

instruction into the computer. Input devices like keyboard, Mouse, Floppy 

drive, Hard disk, scanner, track ball, joy-stick, light pen etc. 

Key-board  

key-board is most commonly used input device of the computer. It is quite 

similar to the typical typewriter. The computer keyboard may have 84 or 

101 or 104 keys. The computer keyboard is arranged in the same order as 

on keyboard of an ordinary typewriter. However, there a few additional 

keys on the computer keyboard. 

Ctrl : The ctrl (control) key is normally located on the bottom corner of the 

keyboard. This key is also called the super-shift key. It’s function is if you 

press and hold ctrl key and then press another key, your computer may 

perform special function. E.g. pressing ctrl with A it will select all the items 

in the window. 

Alt : The Alt key is normally located on the left side of the spacebar key or 

the shift key. As its name suggests, it is an alternated shift key. This key is 

used in combination with other keys to perform a specific function. Alt key 

also be used to reset the pc if it is press with combination of Ctrl and Del. 

Tab : The Tab key found on the keyboard of the pc is similar to the Tab key 

used on the ordinary typewriter, and is used for the same purpose. When 

you press this key, it moves the cursor in the forward direction to the next 

tab stop position. 
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Function Keys : There are 10 or 12 function keys located on the top of the 

keyboard. There are numbered as F1 through F12. The function keys are 

programmable keys and each application can use these keys for a specific 

purpose. For e.g. in word F7 is used to spell check. 

Caps Lock : The caps lock key is used to automatically type all alphabets in 

upper case without pressing the sift key. 

Enter : The Enter key have the same function like typewriter it is used to 

takes the cursor to the next line. It creates a new paragraph.  

Del and Backspace : The Del and Backspace key are used to delete 

keystrokes. 

Ins and Esc : The Ins key is used to select the overtype mode in the 

keyboard. The esc key is a special key that may have different function in 

different programs. 

 

Numeric Keypad: The computer keyboard has an extra numeric keypad 

located on the right hand side. 

There are also direction key, windows key, page up key, page down key, 

home key, end key all these have the special functions. 

 

Explain Hardware and Software. 

Hardware : Hardware is known as the physical devices of the pc The 

hardware does all operations in your pc , such as accepting and storing 

data, performing calculations and displaying or printing results. Monitor, 

floppy disk drive, hard disk drive, keyboard, printer etc are called 

hardware. 
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Software : The various physical devices or the hardware in a pc cannot 

work on their own. To make the hardware work, you require a set of 

programs, a set of program associated with the operation of computer is 

called software. 

Software can be classified into the following categories:   

1 Operating system: e.g. Dos, windows, UNIX, etc. 

2 Programming Languages:  Basic, Cobol, C++,etc. 

3 Application programs:  such as word processors, spreadsheet, data 

base management systems (DBMS) etc, 

4 Other application programs doing a specific job: e.g. accounting, 

whether forecasting, ticket reservation, etc. 

 

Explain Features of MS Word  

The word processor has many unique features as follows: - 

1) Typing easy: In MS WORD typing is so easy because 

a. We need not click enter button after end of the line as the type writer. 

The word processor itself takes matter to the next line of the 

document. This facility is called word wrapping 

b. There is no limit for typing the matter 

c. You can easily correct mistakes as the typing matter appears on the 

screen 

2) Saving: The document type can be stored for future use. We can reserve 

the document for any number of years in word processing 
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3) Adding, removing and applying text: Documents can be modified 

easily in MS office we can easily place a new word in place of existing one. 

The new words will automatically be adjusted in the place of deleted or 

modified text. We can also copy a part or whole of the matter from one 

document to another document 

4) Spell check of words: The spelling of the words in the document can be 

rectified automatically we can also find alternative words to our typed 

words. The grammatical errors can also be corrected in word processor. 

5) Change the style and shape of characters and paragraph: 

The documents in word processor can be made attractive because the 

shape and style of characters in the documents can be changed according to 

our requirement 

6) Bullets and Numbering: 

Bullets are special symbols which can be put for different points, 

paragraphs and documents whereas numbers are ascending figure while 

1,2,3 etc. 

7) Headers and footers: A header is the text appearing above the 

documents and footer is the text appearing below the documents 

8) Creation of tables: If you give directions for required number of rows 

and columns word provides a ready-made table to work 

9) Inserting pictures and objects: In the word processor we can insert 

the pictures in the document to make it more attractive. These pictures can 

be obtain from clip art which is available in word processor 

10) Preview facility: Before getting a print out of our document we can 

get a preview of document if mistakes are there we can change the 

document 
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11) Mail merge facility: If you want to send information to different 

persons there is a facility in word processor known as mail merge the main 

body of the letters can be typed once and we can send the same to different 

addresses. 

 

Explain any ten command from MS 
Word Home Tab  

The Home Tab is about the basics of how text looks when it is printed or 

displayed online. It gives access to both direct and Style-based formatting. 

 

1. Copy:   Copy command generates the same image or copy of selected 

text picture or any objects. Shortcut key of Copy is ( Ctrl + C ) 

2. Cut: Cut Command moves to the selected text, picture or any objects 

from one location to another. Shortcut key of Cut is ( Ctrl + X ) 

3. Paste: There are several ways to use the Paste command that are 

universal to all versions of Microsoft Word. First, you must either use 

the Cut or Copy command to save an item to the Clipboard. Then, to 

paste the last item you cut or copied: 

 Click on the Home tab and then click Paste. 

 Click where you’d like to move or copy the data to (to insert your 

cursor), right-click there, and choose Paste. 
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 Use the key combinations Ctrl + V to paste.  

4. Font face:  These have been a part of Word since at least Word 97. You 

can click on them to give a list to select from or you can type in them. In 

the size window you can type a size that is not on the dropdown list.  In 

the Font window you can start typing the name of a font and it will fill in 

the first font name that fits as you type.  

5. Grow Font: with the help of this command we can Increase Font Size. 

6. Shrink Font: with the help of this command we can Decrease Font Size. 

7. Bold:  with this command, you can do bold (dark, Strong) your selected 

text. 

8. Italic: with this command, you can do italic your selected text. 

9. Underline (Ctrl+U):  Clicking on the Underline button will underscore 

your text. Clicking the little triangle on the right will give you options 

for  the type of underline you want. Once you select an option, that 

option is active during your Word session. 

10. Strikethrough: The Strikethrough button gives you a single line 

through selected text.  

11. Subscript: These decrease the font size proportionally from the 

baseline. Example: H2O 

12. Superscript: These increase the font size proportionally from the 

baseline. Example: X2Y2 

13. Text Effects: Text Effects lets you apply WordArt type appearance to 

text in the body of your document. Unlike WordArt, Text Effects can be  

applied using style. 

14.  Font Color: If you simply click on the font color button, it will give 

you the color shown.  
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15. Text highlight color: Highlight the selected item (the arrow will give 

you color options) 

16. Clear formatting: Clear formatting from the selected item. 

17.  Bullets:  Clicking on the bullet button will give you a bullet, the type 

of bullet will be the last type used by you. You can also define some 

different bullets by click on define new bullets. 

18. Numbering:  The second bullet is for simple numbered lists. Clicking 

on the button will give you a single-level numbered list of the type last 

used.  

19. Align Text: Using the align text you can set four type of alignment 

like left, right, center or justify. Example: if you want to give center align 

for your text, then select your text and click on CENTER ALIGN BUTTON. 

20. Line spacing: Using this command you can set line spacing between 

two or more lines. 

What is Mail Marge? Explain Mail-
marge step by step. 

Mail merge is used to create multiple documents at once. These documents 

have identical layout, formatting, text, and graphics. Only specific sections 

of each document vary and are personalized. The documents Word can 

create with mail merge include bulk labels, letters, envelopes, and emails. 

 Open Microsoft Word: click the Start button, click Programs> 

Microsoft Office> Microsoft Office Word 2007 

 Beginning the Merge Click the Mailings tab, click Start Mail Merge, 

and click Step by Step Mail Merge Wizard. 
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 You will now see a Mail Merge task pane appear on the right side of 

your screen. 

Step 1: Select Document Type Since this handout is for doing a mail merge 

with a letter, make sure that the circle next to Letters is filled in. Then click 

Next: Starting document. 

Step 2: Select Starting Document, we are going to use a current blank 

document, so make sure that the circle next to Use the current document 

is filled in. Then click Next: Select recipients. Please note that in the image 

below that, as you proceed through the Mail Merge Task Panes, you can go 

back and forth at any time you desire by using the Next and Previous 

buttons. 

Step 3: Select Recipients you are now in Task Pane 3. In this task pane 

you will select the source list for your mail merge. Make sure that the circle 

next to Use an existing list is filled in. Then click Browse. Please note that 

you can also use an Access database, Outlook Mail Contacts, or several 

other sources. we will create a new list, so select Type a new list and then 

click Create. 

Step 4 : Create a list by adding data in the New Address List dialog box and  

clicking OK.  Save the list. Note that now that a list has been created, the 

Mail Merge Wizard reverts to Use an existing list and you have the option to 

edit the recipient list.  

Selecting Edit recipient list opens up the Mail Merge Recipients dialog 

box, where you can edit the list and select or unselect records. Click OK to 

accept the list as is.  Click Next: Write your letter.  

Step 5: Write the letter and add custom fields. Click Address block to add 

the recipients' addresses at the top of the document.  
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In the Insert Address Block dialog box, check or uncheck boxes and select 

options on the left until the address appears the way you want it to.  

Step 6: Click Print to print your letters or Edit individual letters to 

further personalize some or all of the letters.  

 
Explain slides command of MS Power 
point 2007 

New Slide: New Slide Click this button to insert a new slide into the 

presentation. The slide will be inserted after the current slide with the 

same format as the current slide. Clicking the arrow will display a gallery of 

different slide layouts. Click any of the slide layouts to insert a new slide 

into the presentation.  

Layout: When this button is clicked, a gallery of different slide layouts will 

appear. Click one of the layouts to apply it to the current slide; the slide 

where the insertion point is located.  

Reset: This button is used to reset the slide position, size, and formatting to 

its default value. 
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Explain Insert tab of MS Power Point  

The Insert Tab is used to insert different features such as tables, pictures, clip 

art, shapes, charts, page numbers, word art, or headers, and footers into a 

presentation. The table below describes each of the groups and buttons 

available on this tab. 

 

 

New Slide:  This button is used to insert a new slide into the presentation. The 

slide will be inserted after the one where the insertion point is located. To 

insert a slide with a different layout, click the arrow at the bottom of the 

button. 

Tables: This button is used to insert a table into a slide. A list will appear with a 

grid that can be used to create the table. Additional options for creating a 

table, such as drawing a table, are also listed. 

Pictures: To insert a picture from a file into the document, click this button. 

The Insert Picture dialog box will appear. This dialog box is used to select the 

picture. 
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Screenshot: This button is used to insert a picture of any program that is not 

minimized to the Task Bar. To insert any part of the screen, click the Screen 

Clipping link. 

Shapes: This button is used to insert different shapes into a slide. A gallery of 

different kinds of shapes will appear when the button is clicked. To insert a 

shape, click the desired shape and then draw the shape in the slide.  

Smart Art: To insert a Smart Art graphic into a slide, click this button. Smart Art 

graphics are objects such as Venn diagrams and organizational charts. When 

the button is clicked, a gallery of different categories and shapes will be 

displayed. 

Chart: Click this button to display the Insert Chart dialog box. This will display a 

gallery of different types of charts that can be created in a Word document. 

Hyperlink: To insert a link to items such as a Web page, another document, or 

an email address, click this button. The Hyperlink dialog box will display where 

the link can be specified. It is also possible to create a new document, 

worksheet, or presentation while creating a link to the item. 

Text Box: Text boxes are used to highlight text within a presentation. Click this 

button to display a gallery of different types of text boxes. Move the mouse 

pointer over the items for a description of each style.  

Header & Footer: This button is used to insert a header or footer into the 

presentation or for handouts. When the button is clicked, the header and 

footer dialog box will display.  

WordArt: Use this button to insert decorative text into a slide. When the 

button is clicked, a gallery of Word Art styles will be displayed. Click one of the 

styles to apply it to the slide.  
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Date and Time: To insert the date and time into the current presentation, click 

this button. The Header and Footer dialog box will display. This dialog box is 

used to insert the Date and Time into the presentation.  

Slide Number: Click this button to insert the slide number into the slide. The 

slide number reflects the position of the slide within the presentation.  

Object: Use this button to insert an object such as an Excel Worksheet or an 

Excel Chart into the presentation 

Video: This button is used to insert a video clip into a presentation slide. 

Videos can be inserted from the Web, Facebook, or from a file that is stored in 

a folder on the computer.  

Audio: To insert a sound or recording into a presentation, click this button. 

Sound can be inserted from Office.com, or a file on the computer. 
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Explain power point Format 
Background dialog box. 
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Methods to Add a PowerPoint Slide Background 

 Using the Design Tab on the Ribbon 

 Click on the Design tab of the ribbon, which contains the features you 

will need to add or change a background in PowerPoint. 

 Click on the Background button on the right end of the ribbon. This will 

open the Format Background dialog box. 

(1) Solid Color: 

Use the Solid Fill Option for a Background 

Solid color choices are shown in the Fill section of the PowerPoint Format 

Background dialog box. 

1. Click the Color drop down button to reveal theme colors, standard 

colors or the More Colors... option. 

2. Choose one of these options. 

(2) Gradient Fill 

Use a Preset Gradient Background 
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PowerPoint has several preset gradient fills available for you to choose as a 

background for your slides. Gradient colors can be effective as a PowerPoint 

background if chosen wisely. Be sure to consider the audience clientele when 

you choose the preset gradient background colors for your presentation. 

1. Click the option for Gradient fill. 

2. Click the drop down Preset 

colors button. 

3. Select a preset gradient fill. 

4. Click the Close button to apply to 

this one slide, or the Apply to 

All button to apply to all slides in 

the presentation. 

 
 

Gradient Fill Types 

Five Different Gradient Fill Types 
For PowerPoint Background 
 Once you have chosen to apply 

a gradient fill to your 
PowerPoint background, you 
have five different options for 
the gradient fill type. 

 Linear 
 Radial 
 Rectangular 
 Path 
 shade from title 
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(3) Pictures & Textured Background 

 

When opting to choose a textured 
background for your PowerPoint 
presentation, choose a subtle 
design and make sure that there is 
good contrast between the 
background and the text. 
 

 
Photographs or clip art can be added as a background for your PowerPoint 

presentations. When you insert a picture or clip art as the background, 

PowerPoint will stretch it to cover the whole slide, if the object is small. This 

can often cause distortion to the graphic object and therefore some photos or 

graphics can be poor choices for backgrounds. 

(4) Pattern Background 

Add a Pattern Background to 
Your Slides 

1. With the Fill section 
chosen, click on Pattern 
fill 

2. Click on the Foreground 
Color: button to choose a 
color. 

3. Click on the Background 
Color: button to choose a 
color. 

4. Click on various pattern 
options to see the effect 
on your slide. 

5. When you have made 
your final choice, 
click Close to apply to this 
one slide or click Apply to 
All. 
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Explain main facilities of MS excel and 
write detail note on MS Excel screen 
components 

There are mainly three types of facilities. They are:  

(i.)  Worksheet/Spreadsheet 

A worksheet or sheet is a single page in a file created with an electronic 

spreadsheet program such as Microsoft Excel. A workbook is the name given to 

an Excel file and contains one or more worksheets. 

A worksheet is used to store, manipulate, and display data. 

The basic storage unit for data in a worksheet is a rectangular-shaped cell 

arranged in a grid pattern in every worksheet. 

(ii.) Database 

In MS Excel mange the data very easily. We can find the data means search 

facility are provided by MS excel. We can also sort data and even if we can 

separate selected data. 

(iii.) graphics 

In MS Excel we can represent the data as graph using Graph facility. 
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Screen components 

 

1) Title bar: 

The title bar displays both the name of the application and the name of the 

spreadsheet. 

2) Ribbon 

The Ribbon is the area on each tab that houses all of the command buttons. 

You may not need all of the commands on a Ribbon. You will come to find that 

you use only what you need.  

3) Status Bar 

The Status Bar, which runs horizontally along the bottom of the screen, can be 

customized to display a number of options, most of which give the user 

information about the current worksheet, data the worksheet contains, 

and the user's keyboard. 
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 Information includes whether the Caps Lock, Scroll Lock, and Num 

Lock keys are turned on or off. 

 The status bar also contains the Zoom slider, which allows users to alter 

the magnification of a worksheet. 

 

4) Column and Rows 

Columns run vertically on a worksheet, and each one is identified by a letter in 

the column heading. 

Rows run horizontally in a worksheet and are identified by a number in 

the row heading. 

Together a column letter and a row number create a cell reference. Each cell in 

the worksheet can be identified by this combination of letters and numbers 

such as A1, F456, or AA34. 

5) Worksheet 

A worksheet or sheet is a single page in a file created with an electronic 

spreadsheet program such as Microsoft Excel. A workbook is the name given to 

an Excel file and contains one or more worksheets. A worksheet is used to 

store, manipulate, and display data. The basic storage unit for data in a 

worksheet is a rectangular-shaped cell arranged in a grid pattern in every 

worksheet. 

6) Cells 

Cell is the rectangular boxes located in the central area of a worksheet. Some 

important notes to know about cells include: 

 Data entered into a worksheet is stored in a cell. Each cell can hold only 

one piece of data at a time. 
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 A cell is the intersection point of a vertical column and a horizontal row. 

 Each cell in the worksheet can be identified by a cell reference, which is 

a combination of letters and numbers such as A1, F456, or AA34. 

7) Formula bar 

The formula bar displays the content of the selected cell. If the cell holds a 

calculation the formula bar will show the formula while the actual cell in the 

grid area will show the result. You can click into the formula bar to update the 

cell content. 

 
Explain MS Excel Insert Command 

If you need to add new data within an existing Excel worksheet, you can insert 

new cells, columns, or rows in the worksheet. 

To insert new cells, rows, or columns in an Excel worksheet, follow these 

steps: 

1. Select the cells, rows, or columns where you want the new, blank cells to 

appear. 

2. Click the drop-down arrow attached to the Insert button in the Cells 

group of the Home tab. 

3. Click Insert Cells on the drop-down menu. 

[1] Insert Cell: 

The Insert dialog box opens with the following options: 

 Shift Cells Right shifts existing cells to the right to make room for the 

blank cells you want to insert. 

 Shift Cells Down instructs Excel to shift existing cells down. This is the 

default option. 
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 Entire Row inserts complete rows in the cell range. You can also select 

the row number on the frame before you choose the Insert command. 

 Entire Column inserts complete columns in the cell range. You can also 

select the column letter on the frame before you choose the Insert 

command. 

 

 

[2] INSERT SHEET ROWS 

Select the heading of the row above where you want to insert additional rows. 

Select the same number of rows as you want to insert. For example, to insert 

five blank rows, select five rows. It’s okay if the rows contain data, because it 

will insert the rows above these rows. Click the selected rows, and then on the 

pop-up menu (dialog box), click Insert. 

[3] INSERT SHEET COLUMNS 

Select the heading of the column to the right of which you want to insert 

additional columns. Select the same number of columns as you want to insert. 

For example, to insert five blank columns, select five columns. It’s okay if the 

columns contain data, because it will insert the columns to the left of these 

rows. Click the selected columns, and then on the pop-up menu, click Insert. 
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[4] INSERT SHEET 

To insert a new worksheet in front of an existing worksheet, select 

that worksheet and then, on the Home tab, in the Cells group, 

click Insert, and then click Insert Sheet. 

You can also right-click the tab of an existing worksheet, and then 

click Insert. On the General tab, click Worksheet, and then click OK. 

 

Explain MS Excel Delete Command 

When you delete a cell (or an entire row or column), follow these 

steps: 

1. Select the cells, rows, or columns you want to delete. 

2. Click the drop-down button attached to the Delete button in 

the Cells group of the Home tab. 

3. Click Delete Cells on the drop-down menu. 

[1] DELETE CELL 

The Delete dialog box opens, showing these options for filling in the 

gaps: 

 Shift Cells Left moves entries from neighboring columns on the 

right to the left to fill in gaps created when you delete the cell 

selection. This is the default option. 

 Shift Cells Up moves entries up from neighboring rows below. 

 Entire Row removes all the rows in the current cell selection. 



 

Prepared By: Kalyani Raval (MJCC) Page 25 
 

 Entire Column deletes all the columns in the current cell 

selection. 

 

 

[2] DELETE SHEET ROWS /COLUMNS 

To quickly delete an entire column or row from the worksheet, you can right-

click the column or row label and select Delete from the shortcut menu (or 

choose Delete Sheet Rows or Delete Sheet Columns from the Delete button’s 

menu). 

[3] DELETE SHEET 

Click the tab of the worksheet that you want to delete. 

Choose Home→Delete→Delete Sheet on the Ribbon, right-click the 

tab and choose Delete from its shortcut menu. 

Click the Delete button or press Enter 
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Basic Application of Computer 
Here are the list of uses or applications of computer: 

 Scientific research 

 Business application 

 Education 

 Entertainment 

 Banks 

 Communication 

 Engineering 

 Medicine 

 Book Publishing 

 Games 

 Personal 

 Accounting 

Let's briefly describe about all the above 12 basic Applications of Computer one by one. 

For Scientific Research 

Scientific research was the first application of computer, as computer was first used to 

perform this job, that is scientific research. At that time to now, the speed and accuracy 

of computer enabled scientific analysis carried out too fast. 

Computer controlled robots must be used in all those areas where there is danger to 

human being such as in nuclear research and deep sea investigation etc. 

For Business Application 

Computer can also be used for the purpose of business. 

Through computer, companies can grow their business as fast as possible through quick 

analysis of their previous project on the computer screen (according to the data feeded 

inside) and deciding what to do next without any delay. 

As from individual to multinational companies, all are using computer for business 

purpose like keeping account information, stocks, prices, items etc. 

For Education 

You can also use your computer system to educate yourself through audio, videos or 

images etc. 
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Now-a-days, there are thousands of websites available over Internet that are ready to 

deliver education for free in almost every subjects. 

You can choose whether you want to learn online or offline. In online learning, you can 

open any website to read your desired topic while in offline learning you can learn 

through videos, PDFs photos etc., all these documents can be downloaded through 

internet. 

For Entertainment 

Most of the persons are using computer for entertainment purposes such as: 

 watching movies 

 watching videos 

 listening songs 

 photos 

 animations etc. 

Computer can be used to create these things in an attractive manner so that user loves to 

enjoy the things. 

In Banks 

Banks are the place where there is continuous uses of computer or we can says that banks 

are the major users of computers. For example, ATM (Automated teller machine) is used 

where we are free to either deposit or withdraw our cash in/from our Bank. 

In banks, all information such as account holders detail, deposits, withdrawal, interest, 

etc. are managed by computers. 

Banks are also using computer network to interconnect all of its branches so that their 

users feel always free to deposit his or her money in any branch of the same bank. 

For Communication 

Using your computer system for the purpose of communication gives you a lot of benefits. 

For example, if you will use email to send message or anything to your friends or any of 

your contacts, then you don't have to use pen and paper to write and take that paper to 

post office and then postman will deliver that later after some or few days that will not 

good if you want to send any urgent information to the same person. 

Therefore, using email, you can also saves your time and cost to deliver any information 

very fast. You only need a computer and internet connectivity. 

Now-a-days, peoples are using chat message, email, voice-mail etc. for communication 

purpose. 
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You can also use computer to communicate through direct video conference with your 

contacts/friends present at any place without any cost except internet connectivity. 

Now you have got enough idea about communication through computer. It's time to move 

on another application of computer which is engineering. 

For Engineering Purposes 

Computer are also using for the purpose of Engineering, that is, to design any machine 

without actually making it through CAD (Computer aided design) softwares and once the 

design is accepted, and then using CAM (Computer aided manufacturing) process 

company can produce a large number of such products at very fast speed. 

Architects are also using computers to draw and design individual houses to big buildings 

like Apartments. There are a lot more uses of computer for engineering purposes. 

For Medicines Related 

Computer plays an important role in medical field also. For example in ICU (Intensive 

Care Unit) chamber in hospital, computer keeps track of each and everything going inside 

the patient's body such as blood pressure and Heartbeat etc. 

Keeping record of patients and medicines are also becomes easy through the use of 

Computer. Computer also plays an important role to perform CT (Computed tomography) 

scan and X-Ray of patients to give the scanned object of specified area of patient's body 

in the form of graphics like images. 

For Book Publishing 

Book publishing becomes an easy task with the use of computer. 

Book publishers are now using DTP (Desktop publishing) software like MS-Word to 

publish their books. 

For Games 

Now-a-days, peoples are using computers most of the time to play games. 

For online games to play, you must have the internet connectivity whereas for offline 

games, you can start without any internet connectivity. 

There are a variety of games available in computer world. Here are some of the category 

available in the game field: 

 action 

 racing 

 adventurous 

 puzzle 



  

KALYANI RAVAL  4 

 

 simulations 

 combat etc. 

Peoples are playing (mostly today's or new generation childs) games on computer for few 

to many hours. 

Some popular games are listed here: 

 Minecraft 

 Counter Strike 

 PubG 

 WoW 

 Grand Theft Auto 

 Skyrim 

 Angry Bird 

 Call of Duty 

 Halo 

 Pokemon 

 Super Mario Bros etc. 

For Personal Use 

Computer can also be used for personal purposes. 

One can use computer system to keep all the day-to-day details that are essential to keep 

anywhere. 

You can use it for personal things such as investments, incomes, expenditures, savings 

etc. 

For Accounting Purposes 

Computers are highly used for accounting purposes to handle company financial accounts 

and inventory management using some accounting software like Tally. 

With the use of computer, the task of maintaining accounts become very easy. Later you 

can also retrieve the data on the basis of various pattern or requirement very easily. 
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